
Installation and Configuration of Monetra

Components

These are the various software offerings we
have. They all relate in some way to our core
product, Monetra itself.

Monetra Installer

Required in order to install any of the other
products listed below.
It handles installation, uninstallation, upgrades,
and license updates
Must be run on the same machine as you are
performing your task (as listed in the previous
bullet)
Same usage of this utility for every OS we run
on. Look, feel, and operation should be identical
no matter the platform.
Supports both online (internet) installations and
upgrades where it will auto-fetch the packages
from our servers, as well as offline if no internet
connectivity is available.
For online mode, it uses the same authentication
as you would log into the _client_ area of our
website (partner logins will NOT work)
For online mode, requires access to
keyserver.mainstreetsoftworks.com
(216.155.126.3) port 443 for fetching license
details, and www.monetra.com (216.155.126.2)
port 443 (or port 80 for non-secured connections)
for fetching the packages to install
Also supports advanced deployments (SQL and
Clustered installs)
NOTE: there are some clients (PapaJohns,
PizzaHut) who do not use the Monetra Installer,
this is by special contract because of their mass
automated deployments, we otherwise _require_
customers to use it as it greatly reduces our
support overhead.

Monetra Payment Engine

This is our core product, Monetra
It has no graphical user interface, it runs only in the background and is controlled via external connections.

Monetra Manager

This is our base configuration utility which performs these tasks:
Provides a graphical user interface to manage the settings in our config files

main.conf, prefs.conf, modules.conf, processors.conf
Located in:

/etc/monetra on Linux/Unix/MacOSX systems
C:\Program Files\Main Street Softworks\Monetra\etc on Windows systems

Generates a unique/random encryption key for the database
Provides an interface to start and stop the Monetra engine
Provides real-time a log viewer interface
Provides the ability to set the run-time debug levels
Provides ability to send support inquiries, encrypted log files and config files
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Provides basic license information
Monetra need not be running to use the Monetra Manager (obviously, since it can start and stop Monetra)
This utility, too, is the same for every OS. Look, feel, and operation should be identical no matter the platform.
This utility can only be run on the same machine as the Monetra Engine resides (though if using a Unix/X11
system, can be viewed remotely through SSH X11 forwarding if desired, or Remote Desktop or VNC on Windows
and Mac, respectively).
Most Unix/Linux people opt not to use this utility and just modify our heavily commented configuration files
themselves.

Monetra Administrator

This is our utility whose primary purpose is to manage user accounts within Monetra
A user account is linked to one or more merchant accounts for processing payments
Add/Edit/Delete/Enable/Disable/Unlock functions

Monetra must be running in order to log into the Monetra Administrator
Must log in as the MADMIN user or an MADMIN sub user
Also used to perform these tasks:

Change the Monetra Administrative (MADMIN) password
Create sub-users for the MADMIN user

Used to create users with access to MADMIN-level functions
Allows a username and password to be assigned to the individual
Allows fine-grained permissions

Export or Import the data from the same or earlier release of Monetra.
Exports are always encrypted, you must store the key returned in the results securely
Imports may or may not be encrypted depending on the version of Monetra it originated from (as of
v7.3, all export files are encrypted)

Can pull a list of system-level statistics on the number of transactions being performed on a per-user or
per-timeframe basis
Ability to pull security audits (every transaction that flows through Monetra as well as the originating
connection)
Ability to pull connectivity error reports (connectivity errors _to_ processing institutions)

This utility, too, is the same for every OS. Look, feel, and operation should be identical no matter the platform.
This utility does NOT need to be run on the same machine as the engine. It is network-enabled and uses a
secure SSL (port 8444) connection for communication. It can also be assigned for a different OS than the Engine
runs on.

Monetra Client

This utility is used to run and manage (e.g. settle, void) transactions, pull reports, etc
Monetra must be running in order to log in using the Monetra Client
Must log in as a standard user (e.g. NOT MADMIN or an MADMIN subuser)
Can also create and manage sub users

Ability to assign usernames and passwords associated with this user account
Restricted, fine-grained permissions with the ability to completely restrict access to sensitive data

Most customers use Monetra through an integrated POS or Web Shopping Cart, so may never use the Monetra
Client, or only use it for administrative tasks like reporting or settlement
This utility, too, is the same for every OS. Look, feel, and operation should be identical no matter the platform.
This utility does NOT need to be run on the same machine as the engine. It is network-enabled and uses a
secure SSL connection for communication. It can also be assigned for a different OS than the Engine runs on.

Monetra Wizard

This is our quick and easy automated setup utility which does these tasks with minimal user interaction:
Generates a database encryption key
Creates all user accounts for a merchant (prompting only for desired usernames and passwords)
Detects and configures modems if applicable, and enables the processing institutions used and sets
appropriate failover logic

The user must store their merchant account information within our key server in order to use the Wizard
Not that many people currently use it, but it is mainly because we do not push it on people at this point. If we ever
start bundling installation support, its use will be mandatory.
This utility, too, is the same for every OS. Look, feel, and operation should be identical no matter the platform.
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This utility can only be run on the same machine as the Monetra Engine resides
Monetra need not be running to run the Wizard, as the wizard will perform initial configuration and auto-start
Monetra

Monetra CardShield Inject

This utility is strictly used for injecting encryption keys into encrypting card readers and key-entry devices
Currently IDTech is the only manufacturer we support

Significant component of our CardShield End-to-End encryption initiative
This utility, though designed to be cross-platform, is currently only supported on Windows and Linux (as USB
code has not been written for other platforms)
This utility, too, is the same for every OS. Look, feel, and operation should be identical no matter the platform.
This utility does NOT need to be run on the same machine as the engine. It is network-enabled and uses a
secure SSL connection for communication. It can also be assigned for a different OS than the Engine runs on.
Monetra must be running in order to use the CardShield Injection utility

Monetra CardShield Client

This utility is meant to be integrated with POS systems.
It is meant to remove POS systems from PA-DSS scope by acting as the layer which takes the user
input/sensitive data.
Must log in as subuser of a standard user (e.g. NOT MADMIN or an MADMIN subuser)
This utility, too, is the same for every OS. Look, feel, and operation should be identical no matter the platform.
This utility does NOT need to be run on the same machine as the engine. It is network-enabled and uses a
secure SSL connection for communication. It can also be assigned for a different OS than the Engine runs on.

Prerequisites

There are no general prerequisites for Monetra other than running on an OS we support, Monetra tries to be as
self-contained as possible

helpful FAQ on supported OS's:  http://www.monetra.com/faq/support/01_os_policy.html
Well, there is one prerequisite, a competent individual performing the installation and configuration that actually
understand the system they are installing on (unfortunately, more rare than you would think)

Windows

None

MacOSX

None

Linux

Must have /etc/init.d/ or /etc/rc.d/init.d directory to put init script, otherwise install may fail

FreeBSD

None

OpenBSD

v4 is only supported

SCO OpenServer

GNU gzip in order to extract our Monetra Installer package
v6 has it already
v5 Available from:  ftp://ftp2.sco.com/pub/skunkware/osr5/vols/gzip-1.2.4-VOLS.tar

A suitable random number/entropy source. This is used for cryptographic operations.
v6 and v5.0.7 appear to already include PRNGd. But if not for some reason, available here:

 ftp://ftp2.sco.com/skunkware/osr5/vols/prngd-0.9.23-VOLS.tar
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If installing the skunkware PRNGd, the socket listens at a non-standard location so a symlink is
necessary:

ln -sf /usr/local/var/prngd/prngd-pool /dev/egd-pool

Solaris

The Monetra Installer may need to add user accounts to the system and does so via the useradd -m ${USER}
method. You must properly configure your system to allow this, specifically, you need to set up the default home
directory. Most sysadmins most likely will have already done this, but if not, this is an easy way:

mkdir -p /export/home
useradd -D -b /export/home

GNU gzip in order to extract our Monetra Installer package
Current versions appear to include this already, if not, download from  http://sunfreeware.com

A suitable random number/entropy source. This is used for cryptographic operations.
Solaris 9 and 10 already have this, and fully patched versions of Solaris 8 (#112438) do as well
If not, either install patch #112438 or  http://www.cosy.sbg.ac.at/~andi/SUNrand/

AIX

Must be running AIX 5.3 TL (Technology Level) 11 or higher

Installation Procedure

Note about GUIs for Unix users performing Remote Installs

It is possible for Linux/Unix users who remotely connect to their server running Monetra to gain access to GUIs,
via 2 potential methods, assuming they have the ability to log in via SSH.

The first method is known as X11 forwarding, where the GUIs run locally on the same host machine as
Monetra, but the display is forwarded to the remote guest. This will work for all GUIs.
The second method is to use an SSH tunnel to forward the necessary ports to connect to Monetra, but the
GUIs run on the remote guest. Since the applications do not run on the same machine as Monetra, not all
GUIs can be supported (e.g. the Monetra Administrator will work, but the Monetra Manager will not).

X11 Forwarding

Requirements on remote Host:
X11 base libraries (X-Server not required)
xauth (used indirectly, by ssh, to extract authorization records from one machine and merge them into
another)
If forwarding through SSH, the /etc/ssh/sshd_config file MUST have X11Forwarding yes enabled

Requirements for local client machine acting as a Guest:
Either an X11 server running, or some sort of emulator:

Windows clients
cygwin with X11 and ssh:  http://x.cygwin.com/
XMing with Putty:  http://www.straightrunning.com/XmingNotes/

Mac clients
X11 should be installed by default, just run it from /Applications/Utilities/X11.app and open
an xterm to perform the connection

Linux/unix clients
A running X11 server (which is true for any desktop-oriented Linux/Unix workstation)

Forwarding using SSH (recommended)
Just run ssh with the -Y flag to enable X11 forwarding: ssh -Y yourusername@remotehost
Once connected, type echo $DISPLAY to see if forwarding is enabled, it should say something like
localhost:10.0
You can then run any X11 application and it should be displayed on your local screen rather than the
remote host's screen
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Forwarding without tunneling (deprecated)
Forwarding without tunneling is deprecated as most X11 servers do not listen on TCP any more and thus
requires a reconfiguration of the X server on the local client (guest). This is not something we will discuss
and is up to you to figure out.
Log into the remote host
Set the 'DISPLAY' environment variable to your IP address or resolvable hostname such as: export
DISPLAY=192.168.1.155:0.0
Run any X11 application, and assuming you don't have firewall issues and your client/guest is listening on
TCP, the X11 application should appear

NOTE: for applications which require 'root' privileges, it may be necessary to use sudo -E to run them. The -E
tells it to preserve the DISPLAY environment variable.

SSH port tunneling

From a Linux/Unix workstation

You are going to ssh in, in a very similar manner to how you would normally ssh in, except you are going to add
an additional option:

-L 8444:localhost:8444

So a full example might be:

ssh -L 8444:localhost:8444 user@remotehost.com

This option tells it to listen on local port 8444, and when a connection comes in, connect to 'localhost' on
the _remote_ machine on port 8444. (Monetra's SSL port).
Note: If you have a local instance of Monetra running on the machine, telling ssh to listen on port 8444 will
conflict. If that is the case, then the first 8444 listing in the command option should change to some
unused port such as 9999.
Once logged in, the tunnel should be established.

From a Windows workstation

A popular SSH client for Windows is Putty, available from  http://www.chiark.greenend.org.uk/~sgtatham/putty
/download.html
If you are unfamiliar with Putty, you should first ssh in normally until you grasp the configuration concepts which
are out of scope for this document.
This SSH client supports port forwarding configuration options under Category->Connection->SSH->Tunnels as
per the screenshot below:
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The source port is the port to listen on, on the local machine. This is typically port 8444 unless you already have
an instance of Monetra running already on your local machine, in which case, you should choose a port which
does not conflict, such as port 9999.
The Destination should always be localhost:8444 as you are connecting to port 8444 local to that remote
machine (Monetra's SSL port).
The 'Local' radio button should be selected.
Other than this configuration change, simply log in, and the tunnel will be automatically established once
authenticated.

Connecting through the established tunnel

Once you are SSH'd in to the machine, leave that SSH session open. If you close it, you won't be able to use the
GUI to connect through the tunnel to Monetra as the tunnel will be shut down.
Open the Monetra GUI you want to use

Configure it to connect to 'localhost' (yes, it sounds odd, but that's the way the tunnel works)
Configure it to use the port you specified for it to listen on. 8444 or 9999 in our examples depending on if
you already have a local instance of Monetra running or not.
Enter your username/password and connect.

That's it!

Administrator's Note

If you administer large numbers of Monetra Engines from a single location, and are using port forwarding, we'd
strongly recommend using different 'listen' ports for each remote location. It is not uncommon to have multiple
SSH sessions open in such an environment, and it can get confusing as to which Monetra you may _really_ be
communicating with. Assigning each forward to a different listen port would effectively resolve that concern. We
gave an example above of using 9999 as an alternate port if Monetra is already running on your local machine,
but that is not the only possible use of changing such a port.

Important note about Unix utilities
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Unix versions of the utilities utilize 'wrapper' shell scripts to import the proper runtime libraries into your
environment. You must NOT run the executable directly (the filename with -bin at the end is the executable, don't
run it) as either it simply will not work, or you may receive random crashes.

Downloading and Installing the Installer

The Monetra Installer can be downloaded directly from our website. User authentication is not necessary to
download the installer:

 http://www.monetra.com/content/downloads.html
The user must choose the installer which is appropriate for their system (OS, 32bit vs 64bit, architecture, etc)
The user must ensure their assigned licenses match the installer they have downloaded, if not, they should
request a license OS/arch change (symptoms discussed later)
OS Specific notes:

Windows: The download is a self-extracting exe (sfx zip archive), which upon extraction runs the Monetra
Installer contained within the archive and performs a self-install
MacOSX: The download is a tar-bzip2'd MacOSX Installer Package. Once downloaded, it can be
extracted by double clicking, then the installer package should be double-clicked to perform the install
using the standard methods for MacOSX
Unix: The download is a tar-gzip'd package that must be extracted, then the monetrainstaller should be
manually executed:

gunzip -c monetrainstaller-linux-x86-glibc23-1.0.18.tar.gz | tar xvpf -
cd monetrainstaller-linux-x86-glibc23-1.0.18
X11 version: ./monetrainstaller
Console version: ./monetrainstaller_console
Follow on-screen instructions for self-install
Cleanup: cd .. && rm -rf monetrainstaller-linux-x86-glibc23-1.0.18*

On all platforms, except MacOSX, the installer performs a self-installation. On MacOSX, for permissions reasons,
we must use the MacOSX Package Installer so the process is different.
On all platforms, except MacOSX, if you download a newer version of the Installer than you currently have
installed, an in-place self-upgrade will be performed (this is useful if the installer cannot self-update for some
reason via the internet or an offline package)
The key file for the Monetra Installer, is the 'installer.xml' file.

Location:
On Unix/MacOSX, in /etc/monetra/installer.xml
On Windows, in C:\Program Files\Main Street Softworks\Monetra
Installer\installer.xml

Running the Monetra Installer after installation (self-installation):
Windows: Click on the Program link under Start->Programs->Monetra->Monetra Installer, or
the Monetra Installer icon on your Desktop, or you can execute it directly from the installed path,
which by default is: C:\Program Files\Main Street Softworks\Monetra
Installer\monetrainstaller.exe
MacOSX: It is installed to /Applications/Monetra/Monetra Installer.app
Unix: Must be run with root privileges. Installed to /usr/local/monetrainstaller/bin/ by default:

Running the console version: sudo /usr/local/monetrainstaller
/bin/monetrainstaller_console
Running the X11 GUI version: gksudo /usr/local/monetrainstaller
/bin/monetrainstaller

Troubleshooting:
If the installer gives a DLOPEN error when trying to load modules, the likely cause is that the temporary
directory being used for package extraction is on a no-exec mounted filesystem (typically on Linux). The
temporary directory is contained within the installer.xml file under the <TmpPath> setting and that must be
changed.
If the installer gives library not found issues or troubles connecting to an X server, try running the console
version which has fewer dependencies
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Internet vs Offline Package

There are 2 modes the Monetra Installer can be run in, online (internet) or offline (downloaded package)
For online installations, you will need the username and password for your account with us. This is the same
username/password you'd use to log into the client area of our website. You would also need to ensure you have
access through your firewall to our servers.
For offline installations, you will need to log into our website and generate an offline package.

Once generated, our website will return you a compressed package that must be downloaded and
extracted prior to the Monetra Installer being able to use it.
You would use the Have Disk or 'Offline' option in the installer, then provide the full path to the directory
created once the compressed offline package is extracted

This directory should contain a file called offline_licenses.xml along with one or more
.marc and .marc.md5 files.

After the initial stage of either entering your username/password for online mode, or providing the path to the
offline package in offline mode, the rest of the usage of the Monetra Installer will be _identical_.
Please see the next section for more information on generating an offline package...

Generating an Offline Package

To generate an offline package, follow the below steps...
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Log into the client area of our website with your username and password1.
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Check the checkbox next to the package you wish to retrieve for an offline install, then click the
'Downloads' button

2.

Make sure all the programs you wish to install have checkboxes next to them
Select the appropriate versions of each license you want to install. It will default to the latest
production versions.

a.

Select the download file format. The default of .zip is appropriate for Windows, you may prefer
.tar.gz for MacOSX or Unix environments

b.

Click the 'Generate Offline Package' buttonc.

3.

Click on the '[Your Monetra Download]' link in order to download your generated offline package4.
Once downloaded, the package must be extracted.

On windows, just double-click your downloaded .zip file and it will open up and show you the files inside.
Then you can click on File->Extract All, and tell it where you want to place those files. Make sure you
remember where you extracted it!
On Unix, for .tar.gz files, you can extract it using a command like this: gunzip -c download.tar.gz
| tar xvpf -

Install all vs Install One at a Time

If the Monetra Installer recognizes that all the licenses on your account are for the same OS, and there are no
duplicate licenses (e.g., you only have 1 Engine, 1 Client GUI, 1 Administrator GUI, etc), it will ask you if you
want to install all packages or not

If you say 'yes', it will install all the products to the _default_ install paths using the _latest_ stable versions
of those products available.
If you need to install to a different path, or select a different version, you must say 'no' if prompted to install
all packages.
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If you selected 'no' or were not provided the prompt at all, you will be provided with a list of available licenses to
install.
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You may select each license 1 at a time, and choose to install them. You will first be prompted for the relevant
version, then the installation path you wish to use.
If you are in online mode, all packages and licensing will be fetched from our servers automatically.
If you find that no packages are available for installation, it is quite likely that you downloaded a Monetra Installer
version which differs from what is licensed for the account you authenticated as. Probably need to contact
support to have your license changed, or uninstall the installer and fetch the appropriate installer for your
platform.
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The Windows ISO (CD Image) exception

If you generated an ISO installation from the client area of our website for Windows, it will perform an automated
install of the Monetra Installer as well as all the GUI utilities with no user interaction necessary. If the customer is
using the Wizard, it will automatically pop up and start taking them through the configuration steps.

Basic Engine Configuration

Generating an encryption key

If using the Monetra Manager, the first time it is run, it will prompt you if you want to generate an encryption key,
simply say 'yes' and that is all you need to do.

If for some reason you need to regenerate your database key, you can do so via the
Manager->Security->Database->Generate. NOTE: this must NOT be done on a live system otherwise you
will lose all data!

If configuring Monetra via a console, run the 'monetra_keygen' utility such as:

/usr/local/monetra/bin/monetra_keygen 256 /usr/local/monetra/my_monetra.key
chown monetra:monetra /usr/local/monetra/my_monetra.key
chmod 660 /usr/local/monetra/my_monetra.key

Enabling the processing institution(s) to use (and connectivity)

Monetra, by default, comes with all processing institutions set to inactive.
This saves resources, each active processing institution spawns one or more threads to handle the load

You must activate the processing institution(s) you use before you are able to add user/merchant accounts
If using the Monetra Manager GUI, click on Processors, then select the Processing Institution you wish to
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activate
Check the 'active' checkbox
In the connection priority setting, move ONLY the connectivity methods you are going to use over to the
'active' column. For instance, if you do not have a modem make sure 'DIAL' is not in the active column.

You should make sure the Active column is ordered by preference of connectivity method (typically
with DIAL as the last option if using Dial Backup)
NOTE: Frame Relay/IP refers to a dedicated circuit. Most customers do not have these as they
cost thousands of dollars per month.
SSL and HTTPS are both secured connections, if a processing institution supports both, then SSL
is preferred, and you should not activate HTTPS (as there are usually additional limitations, e.g.
Tsys/Vital doesn't do Pin-DEBIT via HTTPS)

You might want to verify that the tabs below containing connectivity information such as phone numbers
and URLs appear correct. That said, Monetra's defaults are usually on target for these, you should try
them first before replacing them with other URLs for phone numbers you've received as the ones the
processing institutions provide merchants are often wrong!
Apply and let the Manager restart the engine.
Do for each processing institution you wish to activate.

If you are a command-line guy, just open up the 'processors.conf' in a text editor (typically in /etc/monetra on
Unix systems)

The procedure is very similar to the GUI method, locate the processing institution in the file, each one is
donated as a section (standard .ini format, in square brackets) such as [VITAL]
set the 'active' setting to 'yes' to activate.
Set the 'conn_priority' setting as appropriate.

This is a comma delimited list in order of preference for your connectivity methods.
Possible values: SSL, HTTPS, IP, DIAL, OTHER -- varies by processor, see comments in
processors.conf
Do not list any connectivity methods you do not plan on using. For instance, if you don't have a
modem, do NOT list DIAL.

Verify the authorization and settlement phone numbers and or URLs. Monetra's defaults are usually on
target for these, you should try them first before replacing them with other URLs for phone numbers
you've received as the ones the processing institutions provide merchants are often wrong!
Save and repeat for each processing institution you wish to activate.
NOTE: Monetra must be restarted prior to the changes taking affect.
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Configuring a Modem (primary or backup)

Monetra has been tested across a wide range of modems. Under perfect line conditions (low noise, latency),
Main Street has been successful at processing transactions with _every_ modem we've attempted (30+ from
various manufacturers/chipsets).

If using Dialup as a _primary_ connectivity method, or if your phone line conditions are less than perfect,
or you are traversing a PBX system (avoid if possible) we strongly recommend obtaining a high quality
modem.
Monetra controls very little when it comes to modem communication, if you have issues connecting, or
extremely long delays in processing, or are noticing in your logs a lot of 'NAK' wording, that means you
probably need to have your phone line checked out or upgrade to a better quality modem.
Recommended modems (in preference order): US Robotics External Serial 5686E, US Robotics Internal
PCI 5610C, US Robotics External USB 5637

All recommended modems are 'hardware' modems, not 'win' or 'soft' modems and are known to
work on all OSs

Configuring using the Monetra Manager GUI
Go to Modems, it should display a list of serial devices (or modems) on your system.
Identify the modem you are using and check the 'active' checkbox
Click the edit button, and query the modem for an init string. This will recommend a compatible init string
for your modem.
Apply and let it restart Monetra.
NOTE: If you have more than one modem, you can use them in a failover configuration, the order the
modem appears is the order in which it will be used.
If necessary, specify a dial prefix necessary to get an external line (many PBX systems require you dial '9'
to get an outside line)

Configuring using the command line:
Main Street provides a utility known as monetra_mdmquery which can be used to locate modems, if you
pass the --find-modems flag to the command it will attempt to open and query each serial device on
your system and recommend init strings for the modems it finds:

$ /usr/local/monetra/bin/monetra_mdmquery --find-modems
Detecting modems/serial devices...done
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Querying for modem (/dev/ttyS0) [this may take a while]...failed: timeout waiting on init
Querying for modem (/dev/ttyS1) [this may take a while]...done
Modem Found! Recommended Init String: AT &F0 &C1 &D2 &K0 &N2 &H0 &M0 S11=65

Querying for modem (/dev/ttyS2) [this may take a while]...**tcsetattr(3, TCSANOW, &option
failed: Could not open modem: /dev/ttyS2
Querying for modem (/dev/ttyS3) [this may take a while]...**tcsetattr(3, TCSANOW, &option
failed: Could not open modem: /dev/ttyS3

In the above example, monetra_mdmquery found a modem on /dev/ttyS1 and recommended AT &F0 &C1
&D2 &K0 &N2 &H0 &M0 S11=65 as the init string.
The relevant information we need is the /dev path as well as the Init String that was recommended. You
then need to edit the /etc/monetra/main.conf file to add this information:

modem1=/dev/ttyS1
modem1_Init=AT &F0 &C1 &D2 &K0 &N2 &H0 &M0 S11=65

If you need to dial a prefix to get an outside line, you can configure it as:

modem1_dialprefix=9,

If you need to configure multiple modems, just change the number after 'modem' to reflect it is another
device.
Please reference the other comments in the config file related to modems for additional advanced settings

Troubleshooting
If your modem appears to be connecting, but transactions are not working, it is possible that enabling
'Software 7E1' encoding will fix your problem. Not all modems appear to be able to natively support 7E1
encoding in hardware so this must be done by Monetra in software (if using the manager, go to
Modems->Edit->Advanced to set this).
If Monetra is unable to open your modem, it is possible you did not properly set up permissions (Unix
systems only)

Take a look at the permissions on your modem such as:

$ ls -l /dev/ttyS1
crw-rw---- 1 root dialout 4, 65 2010-06-28 15:51 /dev/ttyS1

Note in our example that the serial device is part of the 'dialout' group. The 'monetra' user must be
added to this 'dialout' group in order to be able to use the modem. An example of how to do this on
Linux might be:

usermod -a -G dialout monetra

A restart of Monetra is necessary for the change to take effect. Possibly, depending on
user/group caching, you may even need to restart the entire computer or flush the
user/group cache.
Please reference your OS vendor for more information on group assignment

Starting, Stopping, and Restarting Monetra

The easiest way to start, stop, or restart Monetra in a cross-platform manner is to use the Monetra Manager GUI.
Under the general section, there is a single button that will say 'start' or 'stop' depending on the current status of
Monetra
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If on Windows, you can also manage the Monetra service:
Administrative Tools->Services->Monetra
Command Line: net start monetra or net stop monetra

If on a unix system, you would use the Monetra init script to manage its state.
On linux, it is in /etc/init.d/monetra or /etc/rc.d/init.d/monetra
On freebsd, it is in /usr/local/etc/rc.d/020.monetra.sh
All other systems it is accessible via /usr/bin/monetrad
The init script can take the commands 'start', 'stop', 'restart', 'status', 'forcequit'

Starting Monetra at Boot

Windows, MacOSX, FreeBSD, Solaris, SCO, AIX -- this is done by default
Linux -- on most distributions, this is done by default, but due to the wide variety of init systems, it may not

Ubuntu: Must add the startup script to your /etc/rc.local
Gentoo: Must add the startup script to your /etc/conf.d/local.start and /etc/conf.d/local.stop (or /etc/conf.d
/local on newer systems)

Basic User Configuration

PreReq: Monetra Administrator GUI

The only user-interactive interface to complete the following steps is the Monetra Administrator GUI.
This is the only supported method of adding users. The legacy/deprecated/unsupported console
monetracadm utility will not be supported and does not include all the necessary functionality.
If you are using your own integrated component to add user accounts, this information does not apply.

Usage Note: Client and Admin profiles (bookmarks)

Both the Monetra Client and Monetra Administrator GUIs use what we call profiles. This tends to be a point of
confusion for most people.
The simplest way to explain it is to draw a parallel. Profiles are no more than 'bookmarks', they simply bookmark
the location of the Monetra Engine you connect to (along with how, SSL, port, etc) and the 'username' you wish
to use.
The profile (bookmark) will only reside on the same machine as you used the Monetra Client and/or
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Administrator on.
The Client and Administrator keep separate profile/bookmark listings
The profile/bookmark is not something stored at the Monetra Engine level, if you go to a different machine that
also has the Monetra Client (or Administrator) installed, the profiles there will only be what were configured on
that machine. Just like if you use a friends computer, the webbrowser wouldn't have _your_ bookmarks, only
theirs.
If you wish to copy the profiles (bookmarks) from one machine to another, it is possible.

On Windows, the profiles are stored in the Windows registry under
HKEY_CURRENT_USER\Software\Main Street Softworks\Monetra Client (or Monetra Admin)
On Unix machines, they are located in ~/.monetra_client.conf (or ~/.monetra_admin.conf) files

The profiles have nothing (directly) to do with the User/Merchant accounts in Monetra, they are just indirect
'references' to that information. If you connect from another machine, you don't have to recreate the
user/merchant accounts, just create the 'bookmark'.
To configure profiles/bookmarks, you need to click on the blue arrow (>) next to the word 'configuration' and the
window will expand to provide the configuration options. During the initial startup of the GUIs for the first time on
a workstation, this will be automatically expanded.
TIP: If you manage a large number of merchant accounts with the Monetra Client GUI, it is usually better to not
create a profile (bookmark) for each user account. Instead, you should check the 'prompt for username'
checkbox in the profile, and it will instead simply prompt for both the username and password rather than storing
the username with the profile.

Logging in with the Monetra Administrator

Run the Monetra Administrator
Windows: Start->Programs->Monetra->Configuration->Monetra Administrator (or the Monetra
Administrator icon on the Desktop)
MacOSX: /Applications/Monetra/Monetra Administrator.app
Unix/X11: by default /usr/local/monetra/bin/monetra_admin

On the first run, the profile configuration box will be expanded. If it is not, click on the arrow '>' next to
'configuration' so it points down.
Enter a profile name, if you only have 1 engine, 'default' is fine. This is just a useful name for you, it is no real
meaning.
Enter a hostname: If Monetra resides on the same machine, this should be 'localhost', otherwise have the IP
address or DNS resolvable hostname ready and enter that information.
Enter a Port: This should be port 8444 unless you have made a custom configuration
Enter a Method: SSL should be chosen, you should not use TCP/IP
Enter a Username: on the initial setup, only 'MADMIN' is supported
Save Profile
Enter the default password of 'password' and click Connect

Changing the MADMIN password
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Upon the first login to the Monetra Administrator with the default password, you will be prompted to change your
password.
Enter the current password of 'password'
Enter the new password you wish to assign, which must be at least 7 characters and contain both letters and
numbers or special characters.
Repeat to make sure it wasn't typo'd in the next field.
Submit.

Adding a User/Merchant Account

In the Monetra Administrator, click on the User Admin tab. You will be shown the current list of users, none
should be listed on an initial install.
Click on the 'Add' button on the right

The 'Add' button on the bottom is for Sub Accounts (split routing, etc) and is discussed in the Advanced
Configuration

Choose a username and password to use, you will need to remember these in order to run transactions through
Monetra.

The password must be at least 7 characters and contain both letters and numbers or special characters
If you wish to receive e-mail notifications from automated settlements, you may enter your e-mail address in the
appropriate field

To specify multiple addresses, semi-colon separate them
From the Processor drop down, choose the processing institution being used

If you do not currently have a merchant account, or you wish to only receive simulated results for testing,
you can choose the 'Monetra Loopback Emulator'

Select the Industry your merchant account is set up to process for
Choose the cardtypes to be accepted via this processing institution. This may directly affect what merchant
account parameters are required, so make sure you choose appropriately.
Enter in the merchant account information into the table below. Blue fields are required. Other fields are either
optional or conditional depending on your setup. For more information on the meaning of each field, when you
click on the field, the description at the bottom of the screen will update, please evaluate carefully.
Submit to save the information, if you receive an error, correct it and continue
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Testing the setup

Running an Authorization

Log into the Monetra Client GUI, this is going to be identical to how you created a profile and logged into the
Monetra Administrator with the exception that you will use the username and password you created in the
previous step. Please note you cannot log in with the MADMIN user to the Monetra Client.
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Assuming you added an account which can process credit cards, go to Credit Card->Sale and run a transaction.
If you are using the Monetra Loopback Emulator, you can use this test information:

Account: 4012888888881881 Exp 0512
Amount: 12.00
Street: 5800 NW 39th AVE STE 104
Zip: 32606
CV: 999

Submit and you should receive an approval, if not, contact support.

Settling a Batch

In the Monetra Client, go to Admin->Settle
You should see a single batch with a single transaction, the test transaction you ran in the previous step.
In the drop-down next to the batch, select the 'Upload' option then submit
The settlement should be successful...
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